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Information documents are not authoritative. Information documents are for information purposes only 
and are intended to provide guidance. In the event of any discrepancy between the information document 
and any authoritative document 0 F

1 in effect, the authoritative document governs. 

1 Purpose 

This information document relates to the following authoritative documents: 

• Section 201.4 of the ISO rules, Submission Methods and Coordination of Submissions (“Section 
201.4”); 

• Section 202.4 of the ISO rules, Managing Long Lead Time Assets (“Section 202.4”);  

• Section 203.1 of the ISO rules, Offers and Bids for Energy (“Section 203.1”); 

• Section 203.3 of the ISO rules, Energy Restatements (“Section 203.3”); 

• Section 204.1 of the ISO rules, Offers for Dispatch Down Service (“Section 204.1”); 

• Section 204.3 of the ISO rules, Dispatch Down Service Restatements (“Section 204.3”); 

• Section 306.5 of the ISO rules, Source Asset Outage Reporting and Coordination (“Section 
306.5”); and 

• Section 306.7 Mothball Outage Reporting (“Section 306.7”). 

The purpose of this information document is to provide pool participants with the AESO submission 
procedures pursuant to subsection 2(1) of Section 201.4. This information document is likely of most 
interest to pool participants that use the Energy Trading System to submit information to the AESO.  

2 Background 

The Energy Trading System submission procedures are outlined in the Energy Trading System manual, 
included in this information document as Appendix 1. This information document is for general information 
purposes only; it is based upon information which is subject to change. While the AESO endeavours to 
keep this manual up-to-date, the AESO assumes no obligation to do so or to notify any party of any 
changes, updates or new versions of this manual. Under no circumstances is the AESO, its members, 
officers, employees, contractors or agents, or any of their respective affiliates, liable for any errors or 
omissions in, or any losses, damages or claims whatsoever, whether in contract, tort or otherwise, arising 
from use of or reliance upon, this manual or any information contained herein. Parties using or relying on 
this manual do so solely at their own risk, and all information contained in this manual should be 
independently verified. 

Appendices 

Appendix 1 – Energy Trading System Pool Participant Manual: Submissions 
  

 
1  “Authoritative document” is the general name given by the AESO to categories of documents made by the AESO 

under the authority of the Electric Utilities Act and associated regulations, and that contain binding legal 
requirements for either market participants of the AESO, or both. Authoritative documents include: the ISO rules, 
the Alberta reliability standards, and the ISO tariff. 
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Revision History 

Posting Date Description of Changes 

2024-11-05 Amended to clarify process for energy submission, 
restatement, and outage scheduling procedures. Referenced 
new CADG terms related to asset constraints in subsection 
12.  

Administrative amendments. 

2024-04-25 Amended to support ETS platform changes in response to the 
new ISO Energy Storage Rules and the addition of the term 
partially controllable assets to the AESO’s Consolidated 
Authoritative Document Glossary. The changes primarily 
consist of updating images to show fields for submitting 
variable energy resource capability.  

2023-06-28 Amended to include Mothball Outages to subsection 7, in 
accordance to ISO Rule 306.7. 

Administrative amendments made throughout document to 
reduce red-tape, fix typographical errors, clarify language, and 
align document with current AESO drafting principles. 

Please note that these amendments take effect on June 28, 
2023. 

2021-03-29 Amended subsection 8.2 of Appendix 1 to provide clarity 
regarding minimum stable generation restatements. 

Amended subsection 15.1 of Appendix 1 to provide clarity 
regarding returning long lead-time assets from an offline state. 

Added section 16 of Appendix 1 to provide information on 
managing operating reserve and energy market offers. 

Administrative amendments made throughout document to 
reduce red-tape, fix typographical errors, clarify language, and 
align document with current AESO drafting principles. 
(this ‘Description of Changes’ cell was updated April 1, 2021) 

2020-03-19 Amended the note in subsection 16.1 to provide clarity 
regarding the submission of Start Time for long-lead time 
energy. 

2019-11-14 Amended to support updated ETS platform. Included new 
reason field in Section 13. Revised to provide clarity in 
Sections 6.1 and 16 and administrative amendments. 
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2016-01-26 Amended to include process to designate a default offer 
control party in the ETS 

Amended to include Internet 9 as a supported platform 

Removed reference to planned outages, testing or 
commissioning of the pool asset, or any changes within plus 
or minus five MW in section 8 

Administrative updates 

2013-01-08 Initial release. 
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1 System Requirements and Digital Certificates 

The supported platform for the Energy Trading System is Microsoft Edge. 

Certain communication with the AESO is handled through the internet, including the process to submit 
bids and offers, register or accept net settlement instructions, and retrieve statements. To ensure that the 
internet-based communication between pool participants and the AESO is secure, pool participants 
cannot receive access to the Energy Trading System without purchasing a digital certificate. 

2 Contact Information 

For information on accessing the Energy Trading System, you may contact info@aeso.ca. 

3 Create a New Energy Submission from Scratch 

3.1 Navigate to the Submission Screen 

(a) Through the AESO website, log on to the system by clicking on the [ETS Login] icon on 
the top right corner of the screen.  

 

(b) Select the desired digital certificate and click on the [OK] button. 

(c) Select the ETS menu. 

Note:  The left side of the screen populates with links to which the pool participant has access. 

mailto:info@aeso.ca
http://www.aeso.ca/
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3.2 Create a New Energy Submission 

(a) Under the ETS menu, select [Submission] tab. 

Note:  The screen opens to the [Submission Information] tab by default. 

(b) Click on the [Energy Submission] tab.  

 

(c) From the [Select Submission Type] list box, choose [New Submission] from the list. 

(d) From the [Select Submission Action] list box, choose Create [New from Scratch] from the 
list.  

Note: From the [Select Submission Action] list, the user has the following options. The 
[Create New from Scratch] option provides a blank submission screen while the 
[Create New from Existing] and [Edit Existing] options provide pre-filled data on 
the submission screen to facilitate quicker data submission. The [Create New 
from Existing] option allows the user to replicate offer structure data from another 
date, whereas the [Edit Existing] option allows the user to edit previously 
submitted data of the same date. 

(e) From the [Select Dispatch Date] list box, choose a date.  
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Note: The dispatch date defaults to the next effective submission date. The next 7 days 
are accessible to create new from scratch, create new from existing and edit 
existing for energy submissions. These 7 days are deemed the forecast 
scheduling period. 

(f) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click the [Next] 
button.  

(g) From the [Select Asset] list box, choose the desired pool asset.  

 

Note: The [Data Entry] tab screen displays the submission filler to the left and the 
submission entry grid is enabled when all fields are empty. Pool participants may 
optionally use the filler to enter its price and real power output offer, and then 
select offer control parties 1F

2, available capability, minimum stable generation, and 
acceptable operational reason. 

 

 
2  See section 15 of this Appendix to determine how to identify one or more offer control party. 
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Note: If the asset is a partially controllable (hybrid), the [Data Entry] tab screen will also 
display the submission filler for Variable Energy Resources (VER). 

Note: The user will see the above message if there are no offer control parties linked to 
the asset. The user must map offer control parties to the asset before an offer 
control party will be available for selection in the filler area. Offer control parties 
are linked using the [Offer Control Maintenance] tab. 

3.3 Link Offer Control and Default Offer Control Parties to Asset 

(a) Click on the [Offer Control Maintenance] tab and select the asset using the adjacent 
checkboxes. All active offer control parties are listed and are not specific to any one 
company. 
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(b) Select one or more offer control party from the [Offer Control Parties] list and use the 
arrows to remove and add an offer control party, as applicable. The offer control parties 
listed have been active in the last 30 days. 

(c) Select the [Submit] button. The Offer Control Party or Parties are now mapped to the 
asset. 

Note: Offer control parties are to be linked to specific assets, including import and 
export assets, prior to inputting energy submissions, dispatch down service 
submissions or historical offer control party submissions in the Energy Trading 
System. 
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(d) A pool participant may also optionally select one or more of the linked offer control parties 
selected, using procedure described in subsection 2.3(c) of this appendix, to be 
designated as default offer control parties for energy submissions and dispatch down 
service submissions.  

This is done by: checking the [Default] checkbox beside each linked offer control party 
that is to be designated as a default Offer Control Party; and selecting the [Submit] 
button.  

Submission applies all default offer control party designations. 

 

Note: If any default Offer Control Party is designated, the Energy Trading System will 
apply the default Offer Control Party to future energy submissions and dispatch 
down service submissions where no offer control party is specified in the Energy 
Trading System submission or restatement. The default offer control party will not 
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be applied to any offer for which the offer control party has already been 
specified at the time of submission. 

Note: The application of a default offer control party at the time of submission will be 
evident from the Energy Trading System submission acknowledgement window. 

Note: The designation of default offer control parties does not add offer control parties 
to any current submissions that are missing offer control, nor does it add offer 
control parties to historical submissions. Details on updating historical offer 
control can be found in Section 6 of this appendix. 

Note: The default offer control party will not be applied to offers for operating reserve 
as there is a separate process in the Energy Trading System for making this 
specification. See the Ancillary Services Restatements and Substitutions manual 
which can be found on the AESO website using the following path: www.aeso.ca 
> Market > Market Participation> System Tools > Energy Trading System (ETS) 
> ETS manuals. 

3.4 Enter the Submission Data for each Applicable Operating Block 

(a) Click on [Energy Submission] tab. 

(b) From the [Select Submission Type] list box, choose [New Submission] from the list. 

(c) Under [Select Submission Action], choose [Create New from Scratch] from the list. 

(d) Under [Select Dispatch Date], choose a date. 

(e) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click the [Next] 
button. 

Note: In the example below, the asset is a source asset. 

(f) From the [Select Asset] list box, choose the desired pool asset. 

(g) From [Begin and End (hour ending)] list boxes on the [Filler] tab, choose the desired 
begin and end time for the desired operating block. 

Note: Hour ending 01 and 24 are the default begin and end times. 

(h) From the [Enter Pricing] section on the [Filler] tab, choose an operating block number.  

Note: [Block 0] is the initial default operating block number. In this example Block 0. 

(i) Enter pricing under [Price ($)]. Press the [Tab] key to move to the next field. In the 
[Amount (MW)] field, enter an energy quantity, referred to as MW amount. 

Note: MW amounts must be entered in whole numbers, while prices can have up to 
2 decimal places. 

(j) Select offer control party using the checkboxes under [Offer Control Parties linked to this 
Asset], then select the [Fill Price & MW and/or Offer Control] button. 

 

http://www.aeso.ca/


Information Document 
Energy Trading System Pool Participant Manual: 
Submissions 
ID #2013-001R 

Posting Date: 2024-11-05 Page 13 of 62 Public 

 

(k) If required, repeat steps a) through j) above until the desired operating blocks are 
completed.  

Note:  Using the [Fill Price & MW and/or Offer Control] button will automatically advance 
the filler to the next block. 

(l) Enter the available capability in the [AC (MW)] field. 

(m) Enter the minimum stable generation in the [MSG (MW)] field. 

(n) For partially controllable (hybrid) assets only, enter the variable energy resource in the 
[VER (MW)] field.  

(o) Enter the reason in the [Reason] field. Select the [Fill AC/MSG] button. 

Note:  To add data individually to each cell, click on the cell and add the data. 
Remember to exit that cell before exiting the screen, or the data from that cell will 
not be added. 

Note: When utilizing multiple operating block offers, the price value is to be greater 
than the price in the previous operating block. The MW amount is to be equal to 
or greater than the previous MW amount operating block offer. 

Note: The pool asset’s available capability must be equal to the maximum capability 
unless the pool participant has submitted an acceptable operational reason. The 
maximum capability is displayed below the entry grid.  
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The final operating block of the offer must equal the maximum capability of the 
pool asset. 

The following is a one-block example where the maximum capability of the asset is 387 MW. 
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The following is a multiple-block example where the maximum capability of the asset is 387 MW. 

 

Note: For reference purposes, all existing Mothball Outages (MBO) currently affecting 
the asset will be displayed in the MBO column. The maximum AC entered must 
be no greater than the maximum capability of the pool asset less any submitted 
MBO.  
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Note: The Variable Energy Resource (VER) column and filler tab is only displayed for 
partially controllable (hybrid) assets. The VER amount entered must be no 
greater than the maximum capability of the pool asset and no less than zero. 
Decimal and negative values are not accepted. 

 

Note: Above each operating block is a [Flex Block] flag button, which indicates whether 
an operating block can be partially dispatched. A pool participant must submit 
whether an operating block is flexible or inflexible as per subsection 3(3)(c) of 
Section 203.1. 

When checked, the “flex block” status applies to the entire operating block for all 
hours of the submission; it is checked by default. Uncheck the [Flex Block] flag to 
deselect it indicating the operating block is inflexible. 

 

Note: Located below the entry grid is the [Clear All] and [Reset] buttons. The [Clear All] 
button removes all entries on the existing screen. The [Reset] button removes 
any changes made to the entries and returns them to their original values. 

 

(p) Click on the [Yes] or [No] radio button beside [Standing Submission] at the bottom of the 
screen. 

Selecting [Yes] allows this submission to be used as a default for future submissions. 
This includes the price and MW amount offer structure, as well as any declared offer 

https://www.aeso.ca/rules-standards-and-tariff/iso-rules/section-203-1-offers-and-bids-for-energy/
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control parties, and the Minimum Stable Generation (MSG) values. These standing 
submissions can be restated closer to the actual dispatch date.  

  

Note that the Available Capability (AC) and Mothball Outage (MBO) values and the 
associated reason(s) are not included as part of a standing submission.  

Note: In order to set up a standing submission, the [Yes] radio button for the standing 
submission option must be selected for the day that is desired as the price and 
MW default for future submissions. Should the [Yes] radio button be selected for 
multiple days, the latest designated standing offer structure from the current date 
becomes the new default offer structure. 

Note: If a standing submission is not set up, the Energy Trading System will 
automatically assign a default offer of the maximum capability at a default price 
of $0 for all 7 days of the forecast scheduling period.  

(q) Select the [Submit] button. 

 

Once the [Submit] button has been selected, a confirmation screen appears containing 
the acknowledgement results of the submission.  
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Error messages are generated if data is not correct upon submission of the values and 
the submission is not accepted.  

(r) Select the [Save], [Print], or [Close] button. The AESO recommends each pool participant 
retain a copy of the acknowledgement for its records.  

3.4.1. Troubleshooting 

Why can’t I access the Energy Trading System? 

A valid digital certificate is required to access the Energy Trading System. Please view our website for 
more information about digital certificates using the following path: www.aeso.ca > Market > Market 
Participation > System Tools > Energy Trading system (ETS) > Accessing ETS. 

The acknowledgement indicates that the submission failed and that there was a validation error. 
What does this mean? 

A validation error is displayed when the submission did not meet the correct criteria. The cause of the 
error will be displayed in the confirmation. For example, if the final operating block does not equal the 
maximum capability, a validation error will occur. Even if the available capability is lower than the 
maximum capability, the last operating block offer must always offer the full maximum capability as per 
subsection 3(4)(a) of Section 203.1. 

I tried using the [Fill Price & MW] function and received an error. Why? 

When utilizing multiple operating block the price value must be greater than the previous operating block 
price. The MW amount must be equal to or greater than the previous MW amount operating block. 

An offer control party is no longer active, but it is showing up in the Offer Control Parties List. 
Why? 

It is up to pool participants to contact the AESO via info@aeso.ca and advise of the “inactive” status of its 
offer control party. The change is implemented by the AESO as soon as practicable, but it is the sole 
responsibility of the pool participant to ensure that it cleans up any future submissions, standing 
submissions, and operating reserve default offer control information where the inactive offer control party 
resides. 

I’ve removed a default offer control party from a pool asset, but it is still showing up in the pool 
asset standing submission? 

When a pool participant removes, or un-maps, an offer control party from a pool asset, it receives a 
message similar to the one below. Each pool participant should ensure that it removes the offer control 
party from all future submissions, any standing submissions, and operating reserves default offer control. 

 

http://www.aeso.ca/
https://www.aeso.ca/rules-standards-and-tariff/iso-rules/section-203-1-offers-and-bids-for-energy/
mailto:info@aeso.ca
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4 Create a New Energy Offer from an Existing Offer 

4.1 Create a New Submission using an Existing Submission  

(a) Click on [Energy Submission] tab. 

(b) From the [Select Submission Type] list box, choose [New Submission] from the list. 

(c) Under [Select Submission Action] choose [Create New using Existing] from the list. 

(d) Under [Select Dispatch Date] choose a date.  

Note: The dispatch date defaults to the next available submission date. In this example, 
the new energy offer is being created for April 9, 2023. 

 

(e) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click [Next]. 

Note: In this example, [Source] is being selected. 

(f) From the [Select Asset] list box, choose the desired pool asset.  

(g) Select the desired submission date from the selection box. 

Note: The [Existing Submissions] screen appears on the right side and provides a 
listing of available historical submissions to select from. 

 

Note: The energy submission grid is populated with previously entered data for the 
selected date. 
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Note: To add or modify data in an individual cell, click on the cell, add the data, and 
press [Enter]. Remember to exit the cell before exiting the screen or the data 
from that cell will not be added.  

(h) Select the [Submit] button.  

(i) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

Error messages are generated if data is not correct upon submission of the values and 
the submission is not accepted.  
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5 Restatements 

Once submitted, values can be restated in the Energy Trading System. This includes revisions to 
available capability, MW, price/quantity, offer control party, and minimum stable generation. 

In the energy submission screen, the options available under [Select Submission Type] depend on the 
delivery date and time of submission. Restatements of applicable hours within next 7 days are handled 
through two options: [New Submission] and [Restatement]. For each delivery day, gate close occurs at 
12:00 p.m. Mountain Time (MT) the day prior. [New Submission] restricts dates to those dates where gate 
close has not yet occurred while [Restatement] restricts to those dates for which gate close has passed. 
For example, if the date is April 28, and it is before 12 p.m., restatements of values for April 29 to May 5 
are available under the [New Submission] option, while restatements for current day, April 28, are 
available under the [Restatement] option. However, if it is after 12 p.m. on April 28, the [New Submission] 
option will only include April 30 to May 5, and the [Restatement] option will include the remaining hours 
within current day and tomorrow, April 28 and April 29. 

To use the [New Submission] or [Restatement] options: 

(a) Click on the [Energy Submission] tab.  

(i) For restatements after gate close: 
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a. From the [Select Submission Type] list box, choose [Restatement] from the list. 
[Edit Existing] will be the only option under the [Select Submission Action] list 
box. 

(ii) For restatements prior to gate close: 

 

a. From the [Select Submission Type] list box, choose [New Submission] from the 
list.  

b. From the [Select Submission Action] list box, choose [Create New from Scratch], 
[Create New from Existing] or [Edit Existing] from the list. 
 

Note:  From the [Select Submission Action] list, the user has the following options. The [Create 
New from Scratch] option provides a blank submission screen while the [Create New 
from Existing] and [Edit Existing] options provide pre-filled data on the submission screen 
to facilitate quicker data submission. The [Create New from Existing] option allows the 
user to replicate offer structure data from another date, whereas the [Edit Existing] option 
allows the user to edit previously submitted data of the same date. 

 
Note:  Each of the options under the [Select Submission Action] list box: [Create New from 

Scratch], [Create New from Existing], or [Edit Existing], will replace any data previously 
submitted into the energy trading system.  
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5.1 Available Capability Restatements 

An available capability restatement consists of restating the pool asset’s available capability when 
a pool participant is unable to provide the pool asset’s maximum capability. Pursuant to Section 
203.3, restatements should be made for any period within the next seven 7 days when there is a 
submission of an offer or bid, or pursuant to Section 306.5, for any planned/forced outages that 
result or will result in a change in available capability any time within the next 24 months. A pool 
participant must also provide a reason with the available capability restatement.  

For further clarification on acceptable operational reasons, and planned/forced outages, please 
refer to the AESO’s Consolidated Authoritative Document Glossary (“CADG”) and Information 
Document #2009-003R, Acceptable Operational Reasons (“ID #2009-003R”), Information 
Document #2012-009R, Restatements, and Information Document #2013-003R, Outages.  

For available capability restatements for any period beyond 7 days, refer to Section 7 Outage 
Scheduling.   

To make an available capability restatement for any hours within the next 7 days: 

(a) Determine the relevant option under [Select Submission Type] by referring to the top of 
this Section 5, either (a)(i) or (a)(ii), based on the desired date to be updated. 

(b) From the [Select Dispatch Date] list box, choose a date.  

Note:  The selection of [New Submission] or [Restatement] under the [Select 
Submission Type] field will dictate the dates available in the ‘Select Dispatch 
Date’ dropdown.  

(c) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click [Next].  

Note:  In this example, Source asset is being used. 

(d) From the [Select Asset Type] list box, choose the desired pool asset from the list. 

Note: The screen that appears will be labelled ‘New Submission’ or ‘Restatement’ 
depending on the selection chosen. In this example, the user has selected the 
restatement option of the current day and the current time is 11:05 am.  
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The Energy Trading System automatically greys out the cells in each operating block that 
are unavailable for modification. During the T-2 period, the price values are greyed out, 
as pool participants are tied to prices for this duration. 

On the [Filler] tab on the left, the [Enter Availability] Section can be used to update 
available capability values. However, the [Begin (hour ending)] field is only accessible 
outside of the T-2 period. All available capability updates within the T-2 period must be 
manually entered on the grid under the [AC] column. 

Note: For reference purposes, all existing Mothball Outages currently affecting the 
asset will be displayed in the MBO column. The maximum AC entered must be 
no greater than the maximum capability of the pool asset less any submitted 
MBO.  

(e)  Enter the desired restated available capability under the [AC] column and the associated 
reason under the [Reason] column.  

 

(f) At the bottom of the screen, click on the [Submit] button to complete the submission.  

 

Note:  Pursuant to Section 203.3, enter an acceptable operational reason when 
restating the available capability of the asset. If the submission meets the 
applicable requirements as defined in the ISO rules, select [Yes] to continue with 
the submission. Select [No] to return to the energy grid to edit or complete the 
acceptable operational reason requirement. 

(g)  [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 
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5.1.1. Troubleshooting 

Why won’t the [Filler] tool won’t make the available capability change in the hour ending I require? 

The [Filler] tool does not work during the T-2 period. Click directly in the cell to be changed and manually 
enter the available capability amount and reason. 

How much detail should I provide for my appropriate acceptable operational reason? 

The Energy Trading System allows up to 1024 characters to record and communicate an acceptable 
operational reason. AESO Compliance Monitoring should understand the purpose of the update and be 
able to differentiate the reasons from an available capability restatement, MW amount restatement or 
minimum stable generation restatement. 

If I make changes to an existing submission using the [New Submission] > [Edit Existing] option, 
does it change the standing submission going forward? 

No, making an edit to an existing submission does not change the standing submission. 

5.2 Create a MW Restatement 

This type of restatement is used when a pool participant has submitted an offer and needs to submit a 
revised offer for its pool asset by restating the amount (MW) to represent the operating state of the pool 
asset. Please see Section 203.3 for the conditions under which an amount (MW) restatement can be 
made.  

For further clarification on acceptable operational reasons, please refer to the CADG and ID #2009-003R. 

To make a MW restatement:   

(a) Determine the correct option under [Select Submission Type] by referring to the top of 
this Section 5, either (a)(i) or (a)(ii), based on the desired date to be updated. 

(b) From the [Select Dispatch Date] list box, choose a date.  

Note:  The selection of [New Submission] or [Restatement] under the [Select 
Submission Type] field will dictate the dates available in the ‘Select Dispatch 
Date’ dropdown.  

(c) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click the [Next] 
button. 

Note:  In this example [Source] has been selected. 

(d) From the [Choose Asset] list box, choose the desired pool asset from the list.  

Note: The screen that appears will be labelled ‘New Submission’ or ‘Restatement’ 
depending on the selection chosen. In this example, the user has selected the 
restatement option of the current day and the current time is 11:38 a.m. During 
the T-2 period, the pool asset has experienced an operational issue that requires 
the generating unit to run at its full capability of 297 MW. In this situation, the pool 
asset cannot comply with its current offer, a price restatement can no longer be 
submitted, and the situation cannot be addressed through a change to the 
available capability. 

(e) Manually move all amounts (MW) to operating block 0 and provide an acceptable 
operational reason. 

Note: In this example, the pool participant moves all 297 MW manually to operating 
block 0, and an acceptable operational reason is provided. The offer control party 
for the blank blocks must also be removed. 
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Note: You may tab over and use your [Delete] key to remove values from the operating 
block cells. In the T-2 period, price is greyed out and unable to be changed. 
Tabbing will skip greyed-out cells.  

(f)  At the bottom of the screen, click on the [Submit] button to complete the submission. 

(g) If the hour endings being restated are within the T-2 period, a warning will appear stating 
[Warning: Confirm that this submission meets the applicable requirements as defined in 
the ISO Rules. Press Yes to proceed with the submission.]  

 

Note: Pursuant to Section 203.3, enter an acceptable operational reason when 
restating the available capability of the asset, as in the above example. If the 
submission meets the applicable requirements as defined in the ISO rules, select 
[Yes] to continue with the submission. Select [No] to return to the energy grid to 
edit or complete the acceptable operational reason requirement. 

(h) [Save], [Print] or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

5.2.1. Troubleshooting 

If I make changes to an existing submission using the [New Submission] > [Edit Existing] option, 
does it change the standing submission going forward? 

No, making an edit to an existing submission does not change the standing submission. 

5.3 Create a Price/Quantity Restatement Prior to T-2 

A price/quantity restatement allows a pool participant to change their price and/or operating block 
amount (MW) for time periods greater than 2 hours before the start of the settlement interval and 
does not require an acceptable operational reason.  
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To make a price/quantity restatement: 

(a) Determine the correct option under [Select Submission Type] by referring to the top of 
this Section 5, either (a)(i) or (a)(ii), based on the desired date to be updated. 

(b) From the [Select Dispatch Date] list box, choose a date.  

Note:  The selection of [New Submission] or [Restatement] under the [Select 
Submission Type] field will dictate the dates available in the ‘Select Dispatch 
Date’ dropdown.  

(c) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click [Next] 

Note:  In this example, [Source] is selected. 

(d) From the [Choose Asset] list box, choose the desired pool asset from the list.  

Note:  The screen that appears will be labelled ‘New Submission’ or ‘Restatement’ 
depending on the selection chosen. In this example, the user has selected the 
restatement option of the current day and the current time is 11:45 a.m. The 
restatement is for an offer that is to be effective in HE24. 

(e) Enter the desired changes in the applicable cells. 

 

Note: To update information outside of the T-2 period, the pool participant may either 
use the [Filler] or manual entry. 
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(f) Click on the [Submit] button.  

(g) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records.  

5.3.1. Troubleshooting 

If I make changes to an existing submission using the [New Submission] > [Edit Existing] option, 
does it change the standing submission going forward? 

No, making an edit to an existing submission does not change the standing submission. 

5.4 Create a Variable Energy Resource Restatement 

A variable energy resource restatement is only applicable for partially controllable (hybrid) assets and it 
consists of restating the pool asset’s variable energy resource when a pool participant is unable to 
provide there previously declared value.  

For further clarification on variable energy resource, please refer to the CADG.  

To make a Variable Energy Resource restatement: 

(a) Determine the correct option under [Select Submission Type] by referring to the top of 
this Section 5, either (a)(i) or (a)(ii), based on the desired date to be updated. 

(b) From the [Select Dispatch Date] list box, choose a date.  

Note:  The selection of [New Submission] or [Restatement] under the [Select 
Submission Type] field will dictate the dates available in the ‘Select Dispatch 
Date’ dropdown.  

(c) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click [Next].  

Note: In this example, Source asset is being used. 
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(d) From the [Select Asset Type] list box, choose the desired pool asset from the list. 

Note: The screen that appears will be labelled ‘New Submission’ or ‘Restatement’ 
depending on the selection chosen. In this example, the user has selected the 
restatement option of the current day and the current time is 11:05 am.  

 

 

As shown in the above restatement screen, the Energy Trading System automatically greys 
out the cells in each operating block that are unavailable for modification.  

On the [Filler] tab on the left, the [Enter Availability] Section can be used to update variable 
energy resource amount. However, the [Begin (hour ending)] field is only accessible outside 
of the T-2 period. All variable energy resource updates within the T-2 period must be 
manually entered on the grid under the [VER] column, like the above example. 

(e) Under the [VER] column, enter the desired restated variable energy resource MW 
amount.  

(f) Click on the [Submit] button.  

(g) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

5.4.1. Troubleshooting 

Some of the price cells are greyed out and I cannot change them. Why? 

Prices within the T-2 period are locked in. During the T-2 period, only the available capability and MW 
amount can be restated with an acceptable operational reason.  

In a voluntary price/quantity restatement, price and/or MW amount may be changed outside of the T-2 
period without an acceptable operational reason. 

If I make changes to an existing submission using the [New Submission] > [Edit Existing] option, 
does it change the standing submission going forward? 

No, making an edit to an existing submission does not change the standing submission. 
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5.5 Offer Control Party Restatement 

To make an Offer Control Party restatement: 

(a) Determine the correct option under [Select Submission Type] by referring to the top of 
this Section 5, either (a)(i) or (a)(ii), based on the desired date to be updated. 

(b) From the [Select Dispatch Date] list box, choose a date.  

Note:  The selection of [New Submission] or [Restatement] under the [Select 
Submission Type[ field will dictate the dates available in the ‘Select Dispatch 
Date’ dropdown.  

(c) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click [Next].  

(d) From the [Select Asset] list, choose the desired pool asset.  

(e) Under the [Offer Control Parties linked to this Asset], select the offer control party 
desired. 

(f) Select the [Fill Price & MW and/or Offer Control] button. 

 

(g) Select the [Submit] button.  

Note: In this example, the Offer Control Party for Block 0 for HE20-24 is restated from 
ABCE to ABCD. As this is outside of the T-2 period, the [Filler] can be used. 

Note: If only the offer control party is being restated, then no acceptable operational 
reason is required. 

(h) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

(i) Within the T-2 period, changes to the offer control parties can only be made in the grid. 
The [Filler] cannot be used.  
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Note: In this example, the Offer Control Party is changing from ABCE to ABCD within 
the T-2 period. 

 

5.5.1. Troubleshooting 

I restated the offer control party for my pool asset within the T-2 period, but wasn’t asked to 
provide any acceptable operational reason. Why? 

If a pool participant changes one or both of the MW amount and the offer control party within the T-2 
period, the pool participant needs to provide an acceptable operational reason. However, if the pool 
participant is only restating the offer control party within the T-2 period, it is not required to provide an 
acceptable operational reason. 

If I make changes to an existing submission using the [New Submission] > [Edit Existing] option, 
does it change the standing submission going forward? 

No, making an edit to an existing submission does not change the standing submission. 

5.6 Minimum Stable Generation Restatement 

For minimum stable generation restatements made within the T-2 period, the Energy Trading System 
provides a warning on submissions when an acceptable operational reason is required. Outside of the T-
2 period, a pool participant must have an acceptable operational reason, but the Energy Trading System 
does not warn pool participants to submit one. 

Within the T-2 period, if the restated minimum stable generation is lower than the previously submitted 
minimum stable generation, the pool participants are not permitted to enter a MW restatement to 
redistribute the MW amount to another operating block. A MW restatement in this circumstance would be 
required only if it satisfies the requirements of Subsection 4(2) of Section 203.3. 

Within the T-2 period, if the restated minimum stable generation is higher than the previously submitted 
minimum stable generation, the pool participant must ensure the minimum stable generation amount is 
contained in the first operating block. If an increase to the operating block size is needed, then such 
amount must be taken from the next highest priced operating blocks in ascending order. 
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To make a minimum stable generation restatement: 

(a) Determine the correct option under [Select Submission Type] by referring to the top of 
this Section 5, either (a)(i) or (a)(ii), based on the desired date to be updated. 

(b) From the [Select Dispatch Date] list box, choose a date.  

Note:  The selection of [New Submission] or [Restatement] under the [Select 
Submission Type] field will dictate the dates available in the ‘Select Dispatch 
Date’ dropdown.  

(c) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click [Next].  

(d) From the [Select Asset] list, choose the desired pool asset. 

Note: To update information outside of the T-2 period, the pool participant may either 
use the [Filler] or manual entry. 

(e) Under the [MSG] column, enter the desired restated minimum stable generation, and if 
required, manually move all amounts (MW) to operating block 0. Provide an acceptable 
operational reason under the [Reason] column.  

 

Note: If the pool participant attempts to submit a restatement that increases the 
minimum stable generation to a value that is higher than the MW amount in the 
first operating block, the following validation error will be displayed. This Energy 
Trading System message can be addressed by either increasing the size of the 
lowest priced non-0 block or by restating the minimum stable generation with an 
acceptable operational reason.  
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5.6.1. Troubleshooting 

If I make changes to an existing submission using the [New Submission] > [Edit Existing] option, 
does it change the standing submission going forward? 

No, making an edit to an existing submission does not change the standing submission. 

6 Energy Historical Offer Control  

A pool participant has the ability to submit offer control party information on a historical basis if it is unable 
to submit the offer control party at the same time as their submission data. Pool participants can edit 
historical offer control parties up to 30 days from the dispatch date. 

6.1 Edit Offer Control 

 Click on the [Energy Submission] tab. 

 

 From the [Select Submission Type] list box, choose [Historical Offer Control] from the list. 

 From the [Select Submission Action] list box, choose [Edit Offer Control] from the list. 

 From the [Select Dispatch Date] – choose any date up to 30 days from the dispatch date. 

Note:  In this example, the date being edited is April 19, 2023. 

 Under [Choose Asset Type], click on [Sink] or [Source] radio button. Click [Next]. 

Note:  In this example [Source] is chosen. 
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Note: All price and MW cells are greyed-out because the offer control party is being 
entered historically, which is after the dispatch date. 

Note: Participants cannot edit historical offer control party information for the current 
day. Edits are only available after midnight. 

 Select offer control party by checking the checkbox from the ‘Offer Control Parties linked 
to this Asset’ list. 

 Select [Fill Offer Control].  

 

 Select the [Submit] button. 
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 [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records.  

 

7 Outage Scheduling 

Pool participants must enter all available capability values for the next 2 years and any upcoming 
Mothball Outages into the [Outage Scheduling] tab in the Energy Trading System, pursuant to Section 
306.5. These values include any changes to the available capability along with the associated reason. 

Maintenance of available capability and reason is done through either the [Energy Submission] tab or the 
[Outage Scheduling] tab in the Energy Trading System. For each delivery day, gate close occurs at 12:00 
p.m. Mountain Time (MT) the day prior. Pool Participants are unable to use the [Outage Scheduling] tab 
to edit hours for which gate close has passed and must use the [Energy Submission] tab instead. For 
example, if the date is April 28, and it is before 12 p.m., the [Outage Scheduling] tab cannot be used to 
modify values for the current day, April 28. However, if the date is April 28, and it is after 12 p.m., the 
[Outage Scheduling] tab cannot be used for the remaining hours of the current day or tomorrow, April 28 
and April 29. 

Maintenance of mothball outage values can only be done through the [Outage Scheduling] tab. 
Modifcations to mothball values is not accessible through the [Energy Submission] tab in the Energy 
Trading System.  

7.1 Create New Available Capability (AC) Outage Entry  

(a) Click on the [Outage Scheduling] tab. 
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(b) From the [Select Type] list box, choose [AC Outage Entry] from the list. 

(c) From the [Result] screen, choose the pool asset. 

(d) Enter required information in the [Data Entry] tab. 

 

Note: For reference purposes, all existing Mothball Outages (MBO) will be displayed in 

the Existing Mothball Outages table. The maximum AC entered must be no 
greater than the maximum capability of the pool asset less any submitted MBO. 

 

(e) Select the [Submit] button. 
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(f) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

7.2 Create New Mothball Outage (MBO) Entry 

(a) Click on the [Outage Scheduling] tab. 

 

(b) From the [Select Type] list box, choose [Mothball Outage Entry] from the list. 

(c) From the [Result] screen, choose the pool asset. 

(d) Enter required information in the [Data Entry] tab. The value entered for Mothball Outage 
Amount is the total amount of MW that is subject to a mothball outage and not available 
for dispatch.  

Note: Submission of a mothball outage will overwrite all current AC information for the 
mothball period, including existing outage information that was previously 
entered in ETS. Additional outage information may need to be re-entered after 
the mothball outage is submitted. 

Note: When a mothball outage is submitted, the reason will be replaced with the reason 

entered by the Participant for the MBO outage, followed by [ ; AC is adjusted as a 
result of MBO declaration.]  
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In this example, the entire asset is mothballed as the value entered is equal to the asset’s maximum 
capability. 

 

Note:  For reference purposes, all existing Mothball Outages (MBO) will be displayed in 
the Existing Mothball Outages table.  

 

(e) Select the [Submit] button. 

(f) A warning will appear, stating [This mothball outage submission will overwrite all current 
AC information for the mothball period, including existing outage information that was 
previously entered in ETS. Additional outage information may need to be re-entered after 
the mothball outage is submitted.]  

 

(g) Click on [OK] to proceed or [Cancel] to revert to the Mothball Outage (MBO) Entry 
screen. 
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(h) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

7.3 View Existing Available Capability and Mothball Outage (MBO) Entries 

(a) Click on the [Outage Scheduling] tab. 

 

(b) From the [Select Type] list box, choose [View Entry]. 

(c) From the [Result] screen, choose the desired pool asset.  

(d) Enter requested date in the [Select Date] calendar and choose [Retrieve] button.  

Note: A pool participant may only view one day at a time. 

The following example does not include a mothball outage.  
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The following example includes a mothball outage.  

 

7.4 Edit Daily Entry for Available Capability Outage 

 Click on the [Outage Scheduling] tab. 

 From the [Select Type] list box, choose [Edit Daily AC Outage] from the list. 

 From the [Result] screen, choose the desired pool asset from the list. 

 Enter requested date in the [Select Date] calendar.  

Note:  Pool participants are unable to use [Edit Daily AC Outage] to edit the hour 
endings for which gate close has passed. Prior to 12:00 p.m. Mountain Time 
(MT), hour endings unavailable to edit include the current day. Past 12:00 p.m. 
MT, hour endings unavailable to edit include the current day plus the next day. 
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Pool Participants must use the [Energy Submission] tab to edit these hours 
instead. 

Pool participants may only edit the hour endings of one day at a time in the [Data 
Entry] tab. Changes for a longer period of time can be completed by selecting 
[AC Outage Entry]. Pool participants will only have the ability to view their MBO 
entries and can not edit them from this screen.  

 Update information. 

 

 [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records.  

7.4.1. Troubleshooting 

My submission is very slow, how do I know if it has gone through successfully? 

The AESO requires pool participants to provide a 24-month outage scheduling information, pursuant to 
Section 306.4 and Section 306.5. When using the Energy Trading System [Outage Scheduling] tab, a 
maximum of 2 years of information can be entered at a time. The below warning will appear to advise 
pool participants not to click on anything while the outage submission is being processed. To confirm that 
information was successfully submitted, an acknowledgement pop-up appears; additionally, the pool 
participant can view its entry by selecting [View Entry] for the appropriate date to ensure the data has 
been populated. If utilizing the file upload option to update the outage scheduling information, only 31 
days of information at a time is accepted. 

 

Do I have to save or print the acknowledgement pop-up? 

No. However, the AESO strongly encourages pool participants retain a copy of the acknowledgment for 
its records and for verification. 
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8 Minimum Stable Generation 

Each pool participant requires the ability to declare the minimum stable generation for its generating 
facility so that the AESO has up-to-date information on the minimum amount MW the pool asset can be 
dispatched down without it resulting in the complete shut down of a pool asset. 

The following description explains how to enter hourly minimum stable generation values in the Energy 
Trading System.  

8.1 Energy Submission Screen 

The hourly declared minimum stable generation values for the stated 24-hour period automatically 
populates all hours for the next 6 days so that a standing submission is maintained. This is entered into 
the Energy Trading System using the [Energy Submission] tab. 

 

Refer to Section 5 of this manual for information on minimum stable generation restatements.  

8.1.1. Troubleshooting 

If submission is not successful, check to ensure the following requirements are met: 

• The minimum stable generation value must be greater than or equal to 0. 

• The minimum stable generation value must be an integer. 

• The minimum stable generation value cannot exceed the maximum capability of the pool 
asset. 
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• The minimum stable generation value plus offer for dispatch down service cannot exceed 
the available capability of the pool asset. 

• The minimum stable generation value must be less than or equal to the value of the first 
operating block containing a volume. 

• The minimum stable generation must be declared in hourly intervals. 

• The minimum stable generation value for importers cannot be greater than 0. 

9 File Upload Formats 

The following description explains the formats used for creating energy offers and ancillary services file 
uploads in the Energy Trading System. 

The file upload format is a flexible method for submitting information using the Energy Trading System 
and is an alterative to entering the information through the user interface. Data for file uploads may be 
entered for multiple days and multiple pool assets for each submission through the Energy Trading 
System.  

9.1 Energy Market Submission Format 

A single form is used to provide submission information, which includes the volumes, prices, and offer 
control party information for the submission periods defined within the forecast scheduling period. 

 

Note: This is an abbreviated table. The fully expanded table format includes all operating 
block prices, operating block amount (MW), offer control parties, available capability, 
and minimum stable generation, along with the associated reason. 
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9.2 Definitions 

To indicate that the line is a comment line, the descriptor "*" is to be added at the beginning of the line in 
Column A. Comments are only for the benefit of the pool participant. 

Submission Amount and Price Row/Column Definitions: 

Row / Column Definition 

R1 CA 
Submission type (“submission”, “historical offer control”, “ddssubmission”, 
“ddsrestatement”). 

R2 CA 

Market type (“energy”, “energyrestatement”, “dds”, “or”, 
“outagescheduling”). 

Note: This row should be omitted for dispatch down service submissions 
and restatements. 

CA 
Starting at row 3, column A must contain the numbers 1 through 5. Each 
number indicates the type of data that must follow in the row.  

R3 CB 
Dates for which the submission data applies.  

Note: This row should be omitted for outage scheduling submissions. 

R4 CB Asset ID, for which the submission data applies.  

Energy Submissions and Restatements Definitions: 

Row / Column Definition 

R5 CB Standing flag for all dates and pool assets stated in rows 1 and 2. An "N" 
declares that the submitted pool asset’s volumes and prices are not a 
standing submission. A "Y" declares that the submitted pool asset’s 
volumes and prices are a standing submission.   

R6 CA Flex flag for each operating block submitted (0 through 6). An "N" declares 
that the submitted pool asset’s volumes are inflexible and the AESO cannot 
partially dispatch them. A "Y" declares that the submitted pool asset’s 
volumes are flexible and the AESO can partially dispatch them.  

CB Starting at row 7, column B contains the submission period, using the hour 
ending, in which the information in the rest of the row applies.  

R7 CC Block Price 0 is the desired price of electric energy when the pool asset is 
issued a dispatch to the operating block 0 MW level. 

R7 CD Block MW 0 is the first level to which a pool asset can be issued a dispatch. 

R7 CE Block 0 offer control parties. 

R7 CF Block Price 1 is the desired price of electric energy when the pool asset is 
issued a dispatch to the defined Operating Block 1 MW level.  

R7 CG Block MW 1 is the next level to which the pool asset can be issued a 
dispatch.  

R7 CH Block 1 offer control parties. 

R7 CI Block Price 2 is the desired price of electric energy when the pool asset is 
issued a dispatch to the defined Operating Block 2 MW level. 
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R7 CJ Block MW 2 is the next level to which the pool asset can be dispatched.  

R7 CK Block 2 offer control parties. 

R7 CL Block Price 3 is the desired price of electric energy when the pool asset is 
dispatched to the defined Operating Block 3 MW level.  

R7 CM Block MW 3 is the next level to which the pool asset can be dispatched.  

R7 CN Block 3 offer control parties. 

R7 CO Block Price 4 is the desired price of electric energy when the pool asset is 
dispatched to the defined Operating Block 4 MW level.  

R7 CP Block MW 4 is the next level to which the pool asset can be dispatched.  

R7 CQ Block 4 offer control parties. 

R7 CR Block Price 5 is the desired price of electric energy when the pool asset is 
dispatched to the defined Operating Block 5 MW level.   

R7 CS Block MW 5 is the next level to which the pool asset can be issued a 
dispatch.  

R7 CT  Block 5 offer control parties.  

R7 CU Block Price 6 is the desired price of electric energy when the pool asset is 
issued a dispatch to the defined Operating Block 6 MW level. 

R7 CV Block MW 6 is the next level to which the pool asset can be issued a 
dispatch. 

R7 CW Block 6 offer control parties. 

R7 CX Available capability for the hour. 

R7 CY Minimum stable generation for the hour. 

R7 CZ 2F

3 Variable Energy Resource for the hour. 

R7 CZ The reason, if necessary, for the difference between available capability 
and maximum capability, and/or the reason for a change to the minimum 
stable generation and/or if there is a change to available capability and offer 
control party. 

 
3  A separate file format is available specially for partially controllable (hybrid) assets that provide a variable energy 

resource submission.  
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Dispatch Down Service Submissions and Restatements Definitions: 

Row / Column Definitions 

CB Starting at row 4, column B contains the submission period, using the hour 
ending, in which the information in the rest of the row applies.  

R4 CC Block Price 0 is the desired price of electric energy when the pool asset is 
issued a dispatch down service dispatch to the submitted Block 0 amount 
MW level. 

R4 CD Block MW 0 is the level to which a pool asset can be issued a dispatch 
down service dispatch. 

R4 CE Block 0 offer control parties. 

R4 CF The dispatch down service submission reason. 

Energy or Dispatch Down Service Historical Offer Control Definitions: 

Row / Column Definitions 

CB Starting at row 5, column B contains the submission period, using the hour 
ending, in which the information in the rest of the row applies.  

R5 CC Block 0 offer control parties. 

R5 CD Block 1 offer control parties. 

R5 CE Block 2 offer control parties. 

R5 CF Block 3 offer control parties. 

R5 CG Block 4 offer control parties. 

R5 CH  Block 5 offer control parties.  

R5 CI Block 6 offer control parties. 

Outage Scheduling Definitions: 

Row / Column Definitions 

R4 CB Outage begin date. 

R4 CC Outage begin time (hour ending). 

R4 CD Outage end date. 

R4 CE Outage end time (hour ending). 

R4 CF Event, such as Retirement, Normal Op, Derate-Forced, Outage-Planned, 
Outage-Forced, or Derate-Planned. 

R4 CG  Availability capability.  

R4 CH The reason, if necessary, for the difference between available capability 
and maximum capability. 
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10 Submissions through a File Upload 

10.1 Create a New File Upload 

(a) Create a new file upload by creating a .csv or .txt format file using the information 
described in this appendix above. The AESO has developed templates to assist pool 
participants if they wish to utilize them. The templates can be found on the AESO website 
using the path: Market > Market Participation > System Tools > Energy Trading System 
(ETS) > File upload examples and templates. 

 

Note: The submissions file upload document should be created in an application 
external to the Energy Trading System, such as Microsoft Excel. 

(b) From the [File] menu, choose [Save As] to save a new file upload. 

The Energy Trading System does not require a specific filename. However, the Energy 
Trading System only accepts files in the .csv and .txt format, which contain comma 
separated values. 

10.2 Create a New File Upload from an Existing File Upload 

(a) Open an existing file upload document in an application external to the Energy Trading 
System. 

(b) Change the date to that of the next submission. 

(c) From the [File] menu, choose [Save As]. 

10.3 Submit the File Upload 

(a) Under the Energy Trading System menu, select [File Upload]. 

https://www.aeso.ca/
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(b) Under [Choose type of file to upload] choose the appropriate option. 

Note: In this example [Submission] has been selected. 

 

 

(c) Under [Select file to upload], click on the [Browse] button. Locate the appropriate file, 
then click [Open]. 

(d) The file name appears in the [Select the file to upload] box. 

(e) Click on the [Submit] button. 

(f) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

10.3.1. Troubleshooting 

The file upload was not successful. Why? 

Ensure the proper formatting has been used. For example, do the “*” and blank lines match the example, 
as the slightest change can alter the success of the file. 

I have attempted to submit my file upload and an error message displays. What do I do? 

If all or part of the submission data is invalid, the submission is rejected. Correct the relevant data 
indicated by the error message and resubmit the corrected file.  

The acknowledgement does not provide details about the submission. How do I know it was 
accepted? 

In the training environment, an acknowledgement without the submission details included is a failed 
submission. 

My file wasn’t accepted. Why? 

Ensure the file is saved in .csv or .txt format, not in the default Microsoft Excel .xls format. 
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I receive an error indicating that there is an error with the date. How do I fix this? 

Dates need to be represented in the format DD/MM/YYYY. 
Excel often converts dates to be DD-MM-YYYY. To remedy 
this, add an apostrophe at the end of the date, as shown 
here: DD/MM/YYYY’. 

If the file upload continues to produce an error rather than 
adding an apostrophe: 

(a) Right click on the cell with the date. 

(b) Select [Format]. 

(c) Select [Custom]. 

(d) Adjust the format to DD/MM/YYYY. 

(e) Select [OK]. 

(f) Directly save and close the document then upload it into the Energy Trading System. 

Note: When the .csv file is opened again it is likely to convert the date back to 
DD-MM-YYYY and the file will need to be reformatted again before closing. 

11 Dispatch Down Service Submissions and Restatements 

11.1 Create a New Dispatch Down Service Submission 

 Under the Energy Trading System menu, select [Submission].  

 Click on the [DDS Submission] tab. 

 

 From the [Select Submission Type] list box, choose [New DDS Submission] from the list. 

 From the [Select Submission Action] list box, choose [Create New from Scratch] from the 
list. 

Note:  From this list, the pool participant also has the option of modifying an existing 
dispatch down service submission or creating a new submission from an existing 
one. This is done in a similar manner to the energy submissions. 

 From the [Select Dispatch Date] list box, choose a date. Click the [Next] button.  

 From the [Select Asset] list, select the desired pool asset.  

Note: The dispatch date defaults to the next effective submission date. 
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Note: The [Data Entry] tab screen displays the submission filler on the left and the 
dispatch down service submission entry grid is enabled when all fields are empty. 

The column noted as “Max DDS” is greyed out and refers to available capability 
minus minimum stable generation = maximum dispatch down service. 

The quantity of each offer for dispatch down service must not exceed the 
available capability less the minimum stable generation level of the source asset. 

Note: At this time, offers for dispatch down service are only 1 operating block in size. A 
dispatch down service operation block is a flexible block. There is no ‘Standing 
Submission’ option for dispatch down service. 

11.2 Enter the Dispatch Down Service Submission Data 

 Use the [Filler] tab on the left side. From [Begin and End Time (hour ending)] list boxes, 
choose the desired begin and end time for Block 0. In this example HE17-24. 

 In the [Price ($)] field, enter a price that is indexed to the pool price. 

Note: Dispatch down service offer price is entered as a negative value. 

 In the [Amount (MW)] field, enter a MW amount. 

 Click on the [Fill Price and MW and/or Offer Control] button. 

 

 Select [Submit]. 
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 [Save], [Print], or [Close] the acknowledgement. The AESO recommends pool 
participants retain a copy of the acknowledgement for their records.  

11.3 Create a New Dispatch Down Historical Offer Control Submission 

 Under the Energy Trading System menu, select [Submission].  

 Click on the [DDS Submission] tab.  

 

 From the [Select Submission Type] list box, choose [Historical Offer Control] from the list. 

 From the [Select Submission Action] list box, choose [Edit Offer Control] from the list. 
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 From the [Select Dispatch Date] list box, choose applicable historical date. Click the 
[Next] button. 

 From the [Select Asset] list box, select the desired pool asset. 

 

 Under [Offer Control Parties linked to this Asset] select the appropriate parties.  

Note: In this example ABCD is being selected for HE01-24.  

 

 Click on the [Fill Offer Control] button. 
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 Select the [Submit] button. 

 [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

11.3.1. Troubleshooting 

Why has the MW amount of my offer been flagged as invalid? 

The MW amount value of the offer for dispatch down service cannot be greater than the available 
capability less minimum stable generation of the pool asset.  

Why am I getting the message that offers are being reset for HE1 and HE2 to $0.00 and 0MW? 

This error occurs when a pool participant attempts to create a new dispatch down service submission for 
the following day from an existing offer after 22:00. 

If the message is ignored, this action results in the resetting of the offers for dispatch down service for 
HE1 and potentially HE2 to $0.00 and 0 MW. 

To prevent this from occurring, exit and perform a dispatch down service restatement instead. 

11.4 Dispatch Down Service Restatements 

In the energy submission screen, the options available under [Select Submission Type] depend on the 
delivery date and time of submission. Restatements of applicable hours within next 7 days is handled 
through 2 options: ‘New DDS Submission’ and ‘DDS Restatement’. For each delivery day, gate close 
occurs at 12:00 p.m. Mountain Time (MT) the day prior. [New DDS Submission] restricts dates to those 
dates where gate close has not yet occurred while [DDS Restatement] restricts to those dates for which 
gate close has passed. For example, if the date is April 28, and it is before 12 p.m., restatements of 
values for April 29 to May 5 is available under the [New DDS Submission] option, while restatements for 
current day, April 28, is available under the [DDS Restatement] option. However, if it is after 12 p.m. on 
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April 28, the [New DDS Submission] option will only include April 30 to May 5 and the [DDS Restatement] 
option will include the remaining hours within current day and tomorrow, April 28 and April 29. 

To make a dispatch down service restatement: 

(a) Click on the [DDS Submission] tab.  

(i) For restatements after gate close: 

 

a. From the [Select Submission Type] list box, choose [DDS Restatement] from the 
list. [DDS Restatement] will be the only option under the [Select Submission 
Action] list box. 

(ii) For restatements prior to gate close: 

 

a. From the [Select Submission Type] list box, choose [New DDS Submission] from 
the list.  

b. From the [Select Submission Action] list box, choose [Create New from Scratch], 
[Create New from Existing] or [Edit Existing] from the list. 

Note:  From the [Select Submission Action] list, the user has the following options. The 
[Create New from Scratch] option provides a blank submission screen while the 
[Create New from Existing] and [Edit Existing] options provide pre-filled data on 
the submission screen to facilitate quicker data submission. The [Create New 
from Existing] option allows the user to replicate offer structure data from another 
date, whereas the [Edit Existing] option allows the user to edit previously 
submitted data of the same date. 
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Note:  Each of the options under the [Select Submission Action] list box: [Create New 
from Scratch], [Create New from Existing], or [Edit Existing], will replace any 
data previously submitted into the energy trading system.  

(b) From the [Select Dispatch Date] list box, choose a date. Click [Next]. 

Note:  The selection of [New DDS Submission] or [DDS Restatement] under the [Select 

Submission Type] field will dictate the dates available in the ‘Select Dispatch Date’ 
dropdown.  

(c) From the [Select Asset Type] list, choose the desired pool asset from the list. 

Note: The following screen appears. In the example below, the time is 1:00 p.m. and the 
restatement is occurring within the T-2 period. Changes within the T-2 period can only be 
made manually through the grid and not the filler. 

 

Within the T-2 period, only the MW amount can be restated. In this example 10 MW is 
being restated to 0 MW in HE14. 
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 If required, manually enter the reason for the change in the reason field to the right of the 
hour ending being restated. If you are restating multiple hour endings, the accompanying 
reason field must be populated with the acceptable operational reason. 

 Click the [Submit] button. 

 [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 

11.4.1. Troubleshooting 

Why can’t I choose the desired hour ending from the Fill box? 

Within the T-2 period, the restatement has to be made by manually entering the data into each 
appropriate cell. 

Can I view my current offers for DDS? 

A pool participant can view the dispatch down service submission in a similar manner to how it views the 
energy submissions. Under the [DDS Submission] tab, choose [View DDS Submission], under the [Select 
Submission Type] list box). In addition, dispatch down service can be viewed from the energy submission 
grid. 

Note:  Dispatch down service cannot be modified from the [Energy Submission] tab. It is only 
displayed for the user’s reference. 

11.5 Energy Restatement Requiring a Dispatch Down Service Restatement 

The following explains the relationship between offers for energy and offers for dispatch down service. 
The example illustrates when a restatement of an offer for energy may require a dispatch down service 
restatement. 

In the following example, the available capability in the [Energy Submission] tab is being restated 
to 0 MW for HE19 within the T-2 period and an acceptable operational reason is provided. 
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However, if a DDS offer currently exists for this asset for HE19, submission of this energy 
restatement will fail because the dispatch down service plus minimum stable generation cannot 
exceed the pool asset’s available capability. 

If an energy restatement invalidates the offer for dispatch down service, the energy restatement 
can only be submitted if the dispatch down offer is restated first.  

 

11.5.1. Troubleshooting 

The Energy Trading System does not process my energy restatement. It says I must adjust my 
offer for dispatch down service. Why? 

If an energy restatement invalidates the offer for dispatch down service, the energy restatement can only 
be submitted after the offer for dispatch down service has been restated. Invalid offers for dispatch down 
service occur when offers for dispatch down service exceed the available capability minus minimum 
stable generation. To restate an offer for dispatch down service, refer to Section 11.4 of this manual, then 
resubmit the energy restatement. 

12 Entering and Maintaining Pool Asset Constraints 

If an offer has been submitted, operating contraints are to be submitted with respect to each source 
asset. 

The definitions of “Ramp rate”, “Minimum off time”, “Minimum on time”, “Initial start-up time”, and “Maximum 

run up time” can be found in the CADG. 



Information Document 
Energy Trading System Pool Participant Manual: 
Submissions 
ID #2013-001R 

Posting Date: 2024-11-05 Page 58 of 62 Public 

12.1 Navigate to the Constraints 

(a) From the [Submission] page, click on the [Constraints] tab. 

 

(b) Under [Choose Asset Type], click on the [Sink] or [Source] radio button. Click the [Next] 
button. 

Note: In this example [Source] is being selected.  

(c) From the [Result] tab, choose the desired pool asset.  

(d) In the [Data Entry] tab, enter the applicable information. 

Note: The fields for the [Ramp rate (MW/min)], the [Initial Start-up time (hr)], and 
[Maximum Runup time (min)], must be populated in order to submit a constraint 
in the Energy Trading System. 

 

(e) Select the [Submit] button.  

(f) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records. 
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12.1.1. Troubleshooting 

How do I view my changes? 

Once constraints are submitted, they remain visible under the [Constraints] tab. To view: 

(a) Go to the [Submission] page. 

(b) Click on the [Constraints] tab. 

(c) Choose [Asset Type], then click the [Next] button. 

(d) From the [Result] tab, choose the desired pool asset.  

Is there a limit to how often I can update the constraints information? 

The [Constraints] tab is available for timely updates whenever constraints information changes. There is 
no limit to how often information can be updated. 

Does this information effect how the pool asset is dispatched? 

If the [Initial Start-up time (hr)] is anything other than 0 or 1, the pool asset is considered a long lead time 
pool asset. There are different procedures that exist when a pool asset is considered long lead time to be 
dispatched by the AESO. 

13 Long Lead Time  

To be considered a long lead time asset, the pool asset must either: require more than 1 hour to 
synchronize to the interconnected electric system under normal operating conditions; or is able to 
synchronize but has varying start-up times for distinct portions of its energy output which require more 
than 1 hour to deliver, such as additional portions of its energy output. 

A pool asset requiring more than 1 hour to synchronize to the interconnected electric system must submit 
to the AESO the time of day that such pool asset will be synchronized to the interconnected electric 
system.  

For more information on long lead time assets, please see Information Document #2012-007R, Long 
Lead Time Energy (“ID #2012-007R”). 

13.1 Long Lead Time Pool Asset Planning to Return from an Offline State 

(a) In the [Enter Start Time] section of the Automated Dispatch and Messaging System, 
select the desired pool asset, and enter an appropriate start time. The start time should 
reflect the time expected to synchronize to the grid. 
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Note: The start-time must be submitted at least 2 hours prior to the beginning of the 
settlement interval. 

(b) Select the [Submit] button. 

Note: Once the start-time has been submitted in the Automated Dispatch and 
Messaging System, the information appears in the energy market merit order. 
This step must be executed in order to appear in the energy market merit order 
as per subsection 2(2) of Section 202.4. If a pool participant deletes an existing 
start-time record, the pool asset is filtered out of the energy market merit order 
and does not receive a dispatch. 

A pool asset that has previously indicated a start-time may withdraw its intention 
up to 2 hours prior to the start of the settlement interval. 

Note: For a long lead time asset that is synchronized but has varying start-up times for 
distinct portions of its energy output (MW) and which requires more than 1 hour 
to deliver such additional portions of its energy, the distinct portions of its energy 
do not require a start-time to be submitted into the Automated Dispatch and 
Messaging System to receive a dispatch. The pool participant would reflect the 
eligibility of the delayed energy to receive a dispatch through their available 
capability declarations as per subsection 4 of Section 202.4 and further 
described in subsection 4 of ID #2012-007R. 

13.1.1. Troubleshooting 

Why can’t I access the Automated Dispatch and Messaging System? 

To access any Automated Dispatch and Messaging System account, a security certificate must be 
installed on a computer. These certificates require the completion of an ADaMS Request Form which can 
be located at on the AESO website through the following path: www.aeso.ca > Market > Market 
Participation > Joining the Energy Market.  

What happens if I restate my long lead time generation to 0 MW? Do I have to restate my start time 
in the Automated Dispatch and Messaging System when my pool asset comes back to an online 
state? 

Once an available capability restatement has been made, long lead time assets must re-enter their new 
start time in the Automated Dispatch and Messaging System as per subsection 2(2) of Section 202.4. 

14 Managing Operating Reserve and Energy Market Offers 

The following explains the relationship between offers for energy and offers for operating reserve. The 
example illustrates when a restatement of an offer for energy with the range between available capability 
and minimum stable generation is lower than the quantity of contracted operating reserves.  

When a restatement is made in the Energy Submission screen, if the AC less the MSG is lower than the 
quantity of contracted operating reserve, the warning below will be displayed stating [WARNING: ‘AC 
minus MSG’ value for 1 or more hours is lower than the quantity of contracted operating reserves. As a 
result of this action, you may have to revise operating reserve submission as soon as practicable.]  

 

In this example, the available capability and minimum stable generation is being restated for HE12. 

https://www.aeso.ca/rules-standards-and-tariff/iso-rules/section-202-4-managing-long-lead-time-assets/
https://www.aeso.ca/assets/Uploads/FORM-ADaMS-Automated-Dispatch-and-Messaging-Systems-Request_Nov-2021.pdf
http://www.aeso.ca/
https://www.aeso.ca/rules-standards-and-tariff/iso-rules/section-202-4-managing-long-lead-time-assets/
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The affected hours will be highlighted in red to point out which settlement intervals have offers that may 
need to be revised. Make necessary revisions as required.  

Note:  Restatements made through the file upload submissions will not generate the 
warning. The warning will only display in the energy submission user interface of 
the Energy Trading System.  

Note: Due to the nature of energy storage assets, these assets are excluded from 
receiving the warning. 

Note: Restatements for Ancillary Services are made using the Ancillary Service tab in 
the Submission area of the Energy Trading System. See the Ancillary Services 
Restatements and Substitutions manual which can be found on the AESO 
website using the following path: www.aeso.ca > Market > Market Participation> 
System Tools > Energy Trading System (ETS) > ETS manuals. 

Note:  Pursuant to Section 203.3, enter an acceptable operational reason when 
restating the available capability of the asset, as in the above example. If the 
submission meets the applicable requirements as defined in the ISO rules, select 
[Yes] to continue with the submission. Select [No] to return to the energy grid to 
edit or complete the acceptable operational reason requirement.  

(a) [Save], [Print], or [Close] the acknowledgement. The AESO recommends each pool 
participant retains a copy of the acknowledgement for its records.  

15 How to Identify an Offer Control Party 

The AESO collects offer control party information from pool participants at an operating block level. That 
means that for every price and quantity pair in an offer to the energy market, up to 7 operating blocks, 
and in an offer to the dispatch down service market (1 operating block), pool participants provide the 
identity of one or more offer control parties for each operating block. 

The AESO collects offer control party information for each transaction that has been cleared by the Watt 
Exchange, or alternative market, that is available to be issued a dispatch by the AESO. For offers made 
to the ancillary services market, for the purpose of compliance with Section 6 of the Fair, Efficient and 

http://www.aeso.ca/
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Open Competition Regulation, this includes offers for both standby and active operating reserves.  

It is anticipated that, in the majority of situations, a single offer control party exists for each operating 
block and that relationship may never change. In the instance that the offer control party does change, 
the pool participant submits the identity of such party to the AESO.  

If more than one party has an ownership stake in a pool asset, the AESO only needs to receive the 
identity of the party or parties that take an active role in the determination of the offers, on an operating 
block specific basis, for that pool asset. “Active role” also includes a party that may not be involved in 
day-to-day offer determinations but has a standing position on the make-up of the offer.  

Examples: 

(a) A pool asset is jointly owned by Company A and Company B. However, Company B’s 
interest is purely financial, and it has no influence in the determination of offers for the 
pool asset. The pool participant should show offer control for each operating block as 
Company A. 

(b) A pool asset is owned by a partnership/joint venture: 

(i) If a delegation of authority has been agreed to between the parties, formally or 
implicitly, then the delegate is the offer control party. In the absence of such an 
agreement the parties need to determine if one or more parties is behaving in such a 
manner that suggests that it is the ultimate decision maker and they should then 
identify themselves as the offer control party, accordingly. 

(ii) If the decisions are made collectively amongst more than one party, then the market 
participant should show each of the offer control parties on an operating block 
specific basis, as applicable. 

(c) If individual operating blocks within an offer are controlled by different parties then the 
pool participant should show the respective parties for each operating block.  

In all situations regarding coordinated efforts between pool participants for submitting offers for energy 
into the power pool, pool participants are reminded to avail themselves of the complete set of 
requirements under the Fair, Efficient and Open Competition Regulation. 

The focus is on collecting the identity of the pool participants that function as offer control parties. This 
approach aids in ensuring that the identities collected are reflective of the actual active players in the 
market.  

Hypothetical Examples: 

(a) Alberta Generator Company Ltd. is a pool participant and a wholly owned subsidiary of 
FEOC Alberta Ltd. Alberta Generator Company Ltd.is the entity that decides how the 
energy from the generating pool asset is offered and as such they would be identified as 
the offer control party, not Alberta Generator Company Ltd.’s parent company.  

(b) Canada Electricity Ltd. is not a pool participant, but it alone decides how the energy from 
the pool asset it owns is offered. Canada Electricity Ltd.is a wholly owned subsidiary of 
06XX29 Alberta Ltd., which is owned entirely by 12YY56 Alberta Ltd. In this situation, the 
offer control party would be identified as the highest company in that corporate hierarchy 
(the ultimate parent company, 12YY56 Alberta Ltd.) as none of the companies in the 
hierarchy are pool participants. However, as the search moves up the corporate structure 
in search of the ultimate parent company, if any of the entities is a pool participant then 
that company is reported as the offer control party. 


